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1.  Introduction

Please read this manual carefully in order to use this software correctly, and understand the 
following: Learn the basic operation of the personal computer for yourself. Use the personal 
computer only for this software. Marantz Electronics, Ltd. and the suppliers are not responsible 
for any damage (including damage and failure of the hardware or other hardware irrespective of 
ordinary damage, special damage or consequential damage) that may directly or indirectly occur 
to the customers in connection with the install or use of this software and any claim from a third 
party.

2.  Outline

CS-Repair is an application software that communicates to PostgreSQL via LAN and display 
inspection data for repairing PCB, or classify the defects for production improvement. Set the 
network adaptor and related devices in advance. HASP is necessary to execute this software. 
Installation of HASP driver is also necessary.

3.  System Requirement

The following systems are necessary to execute CS-Repair.
-   PC with Microsoft Windows XP/Windows 7/Windows 8/Windows 8.1/Windows 10/Windows 11 

Operation System
-  50GB or more free hard disc space (this capacity is only for software,  not for data)
-  Gigabit Ethernet Network Interface (TCP/IP Fixed IP Address)
-  The administrator authority to install and execute CS-Repair.
-  Do not install anti-virus software, and connect PC to only private/closed network.

4.  Installation of CS-Repair

Insert a media and double-click Install.exe in CsRep[xxxx] folder. [xxxx] is a four-digit number
that means the software version. Install.exe may start automatically when the media is CD. Select 
“Install CS-Repair” for installation. Be sure to install the company name, your name and serial No. 
Otherwise, CS-Repair may not work. 
If CS-Repair is not installed in the same PC as CS-Center, Do not start CS-Repair at this point. 
You need to install HASP driver. Select “Install HASP driver ” in order to install the HASP driver. 
After completion of HASP driver installation, insert the HASP key into the USB terminal.  Driver 
setup is executed automatically, and you can now use CS-Repair.
You will receive warning message while installing any Mek software to PC with Windows 7. Please 
just click "Yes", and continue installation.
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5.  Un-installation of CS-Repair

Select CS-Repair from "Add/Delete Application" on the control panel for un-installation.

6.  PC Setting

Set IP Address.  Set the network adaptor and related devices in advance, and TCP/IP should be 
available.

Network Settings 

Open Start menu, select Control Panel. Select “View network status and tasks” in "Network 
and Internet" settings. Select "Local Area Connection".  Select Properties.
Select Internet Protocol version 4 (TCP/IPv4), and press Properties button. Set IP Address, and 
others.

                   

      

Kill FireWall

FireWall must be killed on PC for Catch System.
Open Control Panel, select System and Security. Select Check firewall status.
Select Turn Windows Firewall on or off on left list. Check Turn off Windows Firewall (not 
recommended) on for both network locations.
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Disable the Sleep function

Open Start menu, select Control Panel. Select System and Security. Go to "Change settings
for the plan" menu in Power Options. Select "Never" for "Turn off the display" and
"Put the computer to sleep" settings.

Disable the Screen Saver function

Open Start menu, select Control Panel. Select "Change screen saver" in "Appearance
and Personalization". Select "None" in screen saver function.
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7.  Setting of CS-Repair

Input Password

Start CS-Repair, for the first time the software requests to input password. Input 481120. This 
password is required only for the first time for activation.

Database setting

Set IP address where PostgreSQL is installed. Select Select Database in Settings menu. There are 
4 fields available. Input IP address of PC, where PostgreSQL is installed, in field 1. If you install 
CS-Repair in the same PC as PostgreSQL, input 127.0.0.1. 
The rest of 3 fields can be used to switch database if you use more than one PostgreSQL.  

                                      

Save settings

Before finishing CS-Repair settings, it is recommended to output setting file. Select Set Save... 
from File menu. Input any name. Your CS-Repair's settings will be exported as a file. Store it in 
safety place as backup.
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8.  Main Window

Open Number of PCB inspected

Reload

Next/Prev. PCB

Menu

PCB list

PCB map

Reference Designator
picture

Reference
Designator list

Zoom Reference Designator picture

Zoom PCB map

Next/Prev. Reference Designator
Zoom PCB map

Display Grid
Display Captured pictures
Rotate PCB map

NG/False NG/OK 

Zoom Reference Designator picture

Operator ID

Operator Name

Next/Prev. PCB

Barcode button
AOI Name button
PCB Name button

Classify PCB 
OK/NG/Repair/
Scrap buttons

NG_ID classification
buttons

Show images by Angular Camera

Print

Select column

Judgement Result

9.  Menu

File

Open

Search and select data by opening database of CS-Center directly.  Summarize past data and 
display the graph.
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Select Data
Filter by AOI, PCB or Lot from pull down list, and Filter by Date, and Filter by PCB side.
When filtering by date, by selecting Set date, you can instantly set the date.
(e.g. D0: Today (24 hours),  D1: Yesterday and today (48 hours) W1: 1 week by today)
You can sort the display order by clicking data item name.

AOI Name
 Select AOI name you want to search from pull-down menu if necessary.

PCB Name
Select PCB name you want to search from pull-down menu if necessary.

LOT
Select LOT number you want to search from pull-down menu if necessary.

From Date
Set start date (YYYY/MM/DD, and H:MM:SS) you want to search if necessary.

To Date
Set end date (YYYY/MM/DD, and H:MM:SS) you want to search if necessary.

Set Date
 Set how long you trace back the starting date from end date.

SIDE
Set the side you want to search if necessary.

Search
After inputting filtering condition, press this button.

Clear
Clear filter condition.

Status
Pressing this button, classification status of each data will be shown:
Num.: Total PCB number
Uncheck: PCB not classified
NG Num: Number of NG PCB
NG UnCheck: Number of NG PCB not classified
F NG: Number of False NG PCB
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Period Input
After selecting data, and pressing Open button, window to filter the period is shown.
You can extract the data for selected period.  (e.g. data for only current month, for a week, 
etc.)

Reload

Refresh current data, if inspection continues, then additional inspection data is loaded. 
Latest file saved to CS-Center is loaded while displaying on CS-Repair.

Select from barcode

Enable to select inspection data by inputting PCB barcode.

Select columns

Set the items to be displayed on the window. Cannot be used when [Activate A/B Tree View] is 
ON and [Display grid] is OFF in the [A/B Tree View] settings.

Export

Export data in CSV format. As the dialogue for data output is displayed, input the filter 
condition and the output field of the data to be exported as a file.  The filter condition is the 
starting date through the end date. In case the lot has been input, it is necessary to extract 
the lot equal to the input lot. Select the Fields to be output as a file. The field checked is to be 
output.
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Delete

Delete data. You can delete data from Delete... in File menu. You can delete per Lot, Date or 
PCB Number.　

    

Lot to Delete
Delete data with specified Lot number.

Date to Delete
Delete data with specified production period. Select date for From and To.

Number to Delete
Delete PCB of input number. If you mark Previous, then older PCB will be deleted following 
current PCB.  If you mark Next, then younger PCB will be deleted following current PCB.

Delete OK data

Delete OK data. You can delete OK data from Delete OK data in File menu.
This command deletes data except NG and False NG data. This means to delete data which 
is collected for only checking position shifting (thus called OK data). If you store all data, then 
the data capacity will be enormous. You may execute this menu after confirming components 
positions.

  Caution: If you execute Delete OK data, you can not display XY shift graph or statistics on CS-
Watch (statistics of cumulative position shifting) or CS-Analyzer. 

Print

Print the detail of displayed PCB. PCB information and PCB Map will be printed first, and then 
individual information, NG image, and OK image will be printed.

Rack Print

Input Rack's barcode from keyboard. The list of the PCB in current rack will be listed with 
barcode number.
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Set Save & Set Load

There is possibiliy that PC suddenly stops working, and you have to urgently run CS-Repair on 
another PC. For such trouble, you can export settings file and import it to new PC.
For back up, select Set Save... from File menu. Input any name. Your CS-Repair's settings will 
be exported as a file. Store it in safety place.
Select Set Load... from File menu. Open *.ini file that you created in back up settings file pro-
cedure. 

Exit

Exit CS-Repair.

View

Jump by PCB

Jump to the other PCB from current PCB. 

  Next
Jump to next PCB

  Previous
Jump to previous PCB

  0
Current position

  +5
Jump to the proceeding fifth PCB 

  +10
Jump to the proceeding tenth PCB 

  -5
Jump to the previous fifth PCB

  -10
Jump to the previous tenth PCB

  First
Jump to the first PCB

  Last
Jump to the last PCB

  Number
Jump to the PCB of input number.

Jump by Ref Des

Jump to the other Reference Designator (inspection point) from current Reference Designator.
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  Next
Jump to next Reference Designator

  Previous
Jump to previous Reference Designator

Property

Display the inspection result information of current PCB in text format.

PCB statistics

Display the number of total PCBs, the number of NG PCBs and the NG PCB rate of current 
data.

  

Extract Setting

When displaying only the PCBs that meet the condition, input the condition of the PCBs to be 
extracted. After the Extraction Condition Entry dialogue is displayed, click on the condition of 
the PCBs to be extracted, and input the conditions.

Extraction by lot
This function displays only the PCBs of the specified lot number.
Click on the check box of “Extract by lot” to select this function, and input PCB’s lot 
number to display. Partial coincidence reference is available when putting the * at the head 
of the lot number in the lot item in the total condition of the Data Total.
Example: *01 -> 01a 01b 01c

Extraction by date
This function displays only the PCBs of the specified inspection date.
Click on the check box of the “Extract by date” to select this function, and input the starting 
date and the closing date of the inspection you want to display.
Clicking on the triangle buttons next to the stating date and the closing date displays a 
calendar, so you can input the date by clicking on a date on the calendar.
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Displaying only NG
This function displays only the PCBs with NG.
Check on the check box of “Display only NG” to select this function.Clicking on the OK 
button displays the PCBs that meet the condition.

List

PCB information list is displayed. By double clicking mouse, selected PCB is displayed on 
screen.

Extract NOTE column

Display NOTE column of database per Reference Designator or XY position.  Note column has 
position shifting information, Reference Designator, comment, stamp name and NG comment.
Input both starting and closing date and lot number of the data to extract in Set conditions for 
analyzing NOTE column. 
You can change the width of each item by dragging on the line of the item with the cursor, and 
can re-order data in ascending / descending by pressing the title of each row.
Right clicking on the line of the item displays Sort menu. You can sort the items by selecting 
the sort menu

Copy
This function copies selected (highlighted) data on the clipboard. 

Select All
This function selects (highlights) all items.

Save as CSV
Total results can be saved as a CSV file, which can be loaded by Microsoft Excel. 
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Repair results

Display the repair history list. In Select Operator window, you can set the sort conditions; Start 
and End date, Operator, Number of Repair point, Number of Repair PCB, NG-ID, and PCB 
name. 
By clicking right mouse button, sub-menu is displayed.

Print
Print this list
Preview
Check printing list in preview
Save as CSV
Export data in CSV format  

NG text in new window

When original ID and NG message is set on AOI, the original message is displayed in another 
window.

Length Measurement Statistics

Specify Start Date, End Date, PC name, and PCB name to display analyzed shift data.
Possible to save in CSV file.

HIOKI information

Specify Barcode, File name, PC name, PCB name, Date to display HIOKI data.

Angle Extraction

Specify Start date, End date, PC name, PCB name to display angle extraction.
Possible to save in CSV file.
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Settings

The menus related to setting are as follows:

Select Database

Set IP address where PostgreSQL is installed. If CS-Repair is installed in the same PC, input 
127.0.0.1. If you have more than one PostgreSQL, input the other IP address in field 2, 3 then 4. 
You can switch DB by selecting radio button.

   

General Settings

Menu to set action and barcode settings, it is very important to set each option up to your 
purpose.

Action 1
Display all marks on Reference Designator
This function sets the display method of the marks displayed in the PCB Map when the 
inspection point picture is displayed.
If this function is not selected (not checked), the mark display in PCB map is performed 
only in the area corresponding to the point picture and no mark is displayed in the other 
areas.  If this function is selected (checked), the mark display in the PCB map is performed 
individually. The marks in the area corresponding to the inspection point picture are 
displayed as OK mark.

Lock size of display panels
This function sets the operation at the time when the window size is changed.
If this function is selected (checked), the size of the operation area is kept at the specified 
size or larger even when movement of the splitter or change of the window size changes 
the operation area screen size.
If this function is not selected (checked), the size of the operation area is not controlled.

Do not jump after classification
This sets the action after judging OK, NG and REP. Putting a check mark stays in the 
current PCB position without going to the next PCB. Without the check mark, it goes to the 
next PCB and displays it after judging OK, NG and REP.
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Delete Ref Des images after classification
This sets the movement after judging OK, NG and REP. Putting a check mark deletes the 
individual pictures after judging OK, NG and REP. This function, by using with “Do not jump 
after classification” at the same time, makes it clear that the judgment is finished. Without 
the check mark, Ref Des pictures are not deleted after judging OK, NG and REP. Delete 
confirmation is indicated after the last change.

Confirm classification when classification is finished
By checking this, the display for confirmation pops up after classification. 

Alert no Ref Des classification
Make an alert before moving to next PCB if each Reference Designator (inspection point) is 
not classified OK, NG or Rep. Select [Yes] to move to the PCB. Select [No] to stay.

Verification input delay (S)
When classifying Reference Designators from keyboard, you can set keyboard input interval 
in second to avoid the operator's continuous keyboard pressing.

Sort Results
Re-order Reference Designator data in Ref Des Status window by selected item. The 
setting is applied after reloading data.

Auto reloading
Automatically reload the latest data. Input ideal reloading timing in second.

Load both A and B side data automatically 
Normally, even if your inspection program has A face (surface) and B face (back), only one 
face is loaded in CS-Repair. However if you check this option, both faces are loaded and 
CS-Repair displays A face by B face. 

  Remarks: To use this option, the PCB must have barcode. And 'Didplay in barcode order' 
option in Barcode tab must be checked.

If PCB is occupied, move to next PCB
If selected PCB is occupied by other operator, skip it and move to the next PCB.

Display all PCB including Good PCB
Normally, PCB displayed on PCB Status list is according to the status of NG/Good/OK 
button. By checking this option, all PCB are listed on PCB Status area.
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Action2
Show BlockMark on Ref.Des. list
Normally Block Mark is not shown and not listed on Symbol list. If this is checked, 
blockmark is also listed. This should be checked if your PCB is panellized PCB, and you 
want to know the skipped panel. 

Create OK Ref.Des. image from Cell image
By activating this, Picture of Good Reference Designator can be shown by clipping from 
Cell image. Since version 2.0.1.0, when multiple OK images are saved, they can be 
switched on the Result screen.

Use A-Z keys for classification
Normally only number keys can be used for classification, however by activating this, 
alphatet is also usable. Be careful that CS-Analyzer can only handle number keys.

PC startup, waiting time (second)
 Set waiting time for CsRepair start-up when restart PC.

List unclassified PCB only
Display only unclassified PCB.

Show NG PCB by fiducial reading failure
Display NG PCB which failed to read the fiducial.

Auto-reload by clicking Next (grey-out) button at the last PCB
Execute reloading by clicking Next button while selecting the last PCB in list.

Touch screen buttons
Large button is display for touch panel function.

Print uses format 2
Print with special format by pressing Print button in Toolbar.

Only the original error message is shown
Display only error text when there is original error text.  If there is no error, display nothing.
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Display check information file mode
Mode to read and display the inspection data file saved by CsCenter.

The number of NG is shown to number of blocks
Change displayed number of NG to number of blocks.

When loading Dual side machine, AB mode is made enabled
Function to read A & B side is active automatically when reading dual inspection machine.

Lengthen the cross line of the panoramic picture
Display the long cross line at circled position in PCB Map.

Rotate inspection image whan rotating PCB image
When rotating the Map View image, the inspection image (including cell image) will also be 
rotated. Note that in the case of individual pictures, the master picture is also rotated.

Barcode
Search location
    Current file only: Search barcode in currently loaded data.
    All data:        Search barcode in database.

If Duplicate barcode exists
   Select latest barcode:  The latest barcode is selected.
   Select from list:  The list is displayed and you can select from the list.

Barcode reader
RS-232C Serial: If using external barcode reader, select this option. Then setting 
icon on right will be activated. Set Port, Baud rate, Parity, Data bit and Flow control 
depending on your barcode reader from this icon window.

Barcode search mode
   Barcode number: Search from barcode number.
   Pc Name & Time: Search from AOI name and time.

Display in barcode order
If you inspect 50% of PCB on one AOI and 50% of PCB on another AOI, you should check 
this option. Then these 50% data will be displayed as one inspection data on CS-Repair. 
Also you should check this option when classifying or repairing side A+B inspection data.
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Priority for Rack BarCode
Call barcode attached on rack. When this is checked, all PCB in one rack is listed. 

           * Barcode attached on rack has no relation with Rack number in PCB status list.

Barcode2
Load both A and B side data when reading block barcode
Show side B data too when side A's Block barcode is searched. 

Barcode scanning input speed
When handy scanner's data transmission is too fast or too slow, change minimum speed 
(Parameter 1) or maximum speed (Parameter 2). 

Barcode Format
By specifying the barcode format, the barcode is separated into barcode information, Map 
View rotation information, and invalid characters. The following three format specifiers are 
used.
* barcode specifier
/ Map View rotation information
# Invalid character

Map View rotation setting specifies to which rotation angle (0, 90, 180, or 270) the character 
specified with / is assigned. When a barcode search is performed, a Map View is displayed 
at the specified rotation position when the data is displayed.
E.g.) Format [ ////#******* ], barcode [180-ABCDEFG]
Barcode  ABCDEFG
Rotation  180

Display single PCB if PCB-BarCode = Panel-BarCode
Display only judged individual PCB when searching by PCB barcode.

Do not search Panel barcode
Activate the function not to search barcode.
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From CS-Center
This setting is used when receiving inspection information notification immediately after an 
inspection from CS-Center.
When data is received from CS-Center, data is displayed based on the received inspection 
information.On the CS-Center side, this setting is configured from [CS-Repair / CS-Guide] 
in [Address Settings].

Receive data from CS-Center
  Check this box to receive inspection information from CS-Center. 

Start/Stop
  Start: Starts the connection for data reception. 
  Stop: Stops the connection for data reception.

Port  
  Sets the port number to be opened on the CS-Repair side.

CsWatch
Update data on CsWatch after repairing
Usually, data displayed as graphs on CS-Watch is the data right after inspection. With this 
option on, data after repairing/classifying/verifying on CS-Repair is sent to CS-Watch. 
This means that data on CS-Watch becomes more in details. e.g. If you set AOI to send all 
NG automatically, there can be false NG also in the NG data. But after verifying data on CS-
Repair, only real NG is listed on CS-Center.

    

Others
Pixel per mm.
The value is used when measuring actual size on NG point picture when it is displayed in 
zoomed Reference Designator window. Display the object you want to measure the size, 
and size in pixel and size in mm will be displayed at bottom of the screen when you drag it 
with right click. Input proper value to meet your AOI.

Pixel size in NG Circle
Change NG circle size from 1 - 15 pixel.
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Split data per LOT in Select Data list.
Normally, when you select data, you can select per Lot. But if this option is ON, you can 
select data regardless Lot.

Do not change edit position when reloading
Do not change the current edit position in PCB list when reloading.

CsCenter Message
Display the message to CS-Repair when data is not combined even you use the 
combination function in CS-Center.  Put check to "Receive and display CsCenter message", 
and set Port to "Port to communicate with CsCenter".

When Ref Des do not exist Press OK button to process PCBOK
Process PCB OK by pressing OK button when Ref Des does not exist.

Disable function key
Make function keys inactive.

Quit the software without confirming
Does not display notice message while quitting the software.

Does not move except for first time in individual NG judgement
Allows to move to next file just for the first time on NG judgement.

Allow double start
Enable to launch CS-Repair doubly while CS-Repair is already active.

Make AB display list old
Change inspection data lists into old type. Data is displayed by inspected time series.
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XML
Output XML after classification. File per panel or File per PCB is selectable, and set the 
output location. The XML format is same as the XML output on CS-Center.

It is sent to the HTTP server
Send XML data to HTTP server.  File per panel or File per PCB is selectable, and set the 
output location.  Set HTTP server address in “Host”.  Set the time in “Time Out” for server 
communication. Set time is in seconds.

XML2
Set the function for XML output.

Reference Designator without ( ) and [ ]
If ( ) and/or [ ] is included in Reference Designator of XML output, delete ( ) and [ ] when 
output XML.

Change error type from "F" to "-"
Output XML with "-" when error type of XML output is "F".

Data without barcode is not output to XML
Excepts for data without barcode.

NG of BlockMark makes judgement of XML output OK
Normally, if a BlockMark is NG, the output is [NG]. By turning this setting ON, the
output can be set to [OK] or [Empty].

Lot is Exported
Exports LOT to XML.

Output XML on the same PCB
Outputs XML though the same PCB on judgement.

Angular Cameras images is Exported
Exports angular camera images into same folder as Ref.Des. images.
This option is available when Image option on XML tab is active.

File only for NG Panel/PCB
Outputs only PCB information that is judged as NG by inspection machine to XML.
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pcb_Number
Depending on the settings you select, the output content in the XML file will be switched. 
Number: Serial number of the block in the XML output
BlockNumber: Block number in the inspection result 

* In software version 2.0.0.7 or later, BlockNumber is output sorted by block number.

The x part of the following data will change. 
<serial_pcb_x> 
<status_pcb_x> 
<pcb_no>x</pcb_no>

  

RS232C
Connecting option with particular system.

Side Camera
Window is opened and closed automatically
Open/Close Angular Camera view window when data has angular camera data.

Views for NG direction in Pack be noticeable
Same as angular camera screen on AOI, shadowing unnecessary views for easy viewing.

Show only NG direction in 4 views
Same as angular camera screen on AOI, do not show all 9 views but show only 4 views.

Measure angle by right mouse dragging
Measure the angle by right-click the mouse.  Right-click at starting point, and drag through 
to end point to set reference line. Right-click at starting point of measurement point, and 
drag through end point to set measurement line.  Angle will be displayed at the lower part 
of screen.  Possible to save the measurement line and result by clicking save button if 
measured by enlarged screen.

Password
Require password to open General Settings
Protect General Settings by password being touched by anyone.

Addin
Use only for the operation of special specification.  Normally it is blank, and no need to input 
anything.
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DB Password
DB Password is normall not used. Only if you assigned other password than postgres1, 
input the other password here. Otherwise CS-Watch will be refused to connect.

Use Operator Login
Inputting the user name and password is required when starting up CS-Repair. 

Auto logout notification
Sets the time to automatically logout if there is no specific operation.

A/B Tree View 

Activate A/B Tree View
Display the screen with tree view.  Need to restart CsRepair.

Show side B automatically after classifying side A
 Display B face (back) after classifying A face (surface).

Display in Date order
 Display the list of PCB by date.

It expands automatically
 Display the tree list automatically when PCB is selected.

Display grid
Display the grid similar to normal display in A/B Tree view.

Use F9 for A side switching and F12 for B sie switching
Use F9 key for switching to A side, and F12 key for switching to B side.

Use Side-A block barcode for Side-B search function
Use Side-A block barcode for Side-B search function.  (When there is no barcode in Side-B, 
and showing only Single PCB)

Skip if no RefDes data when moving data
Data that does not display RefDes data is skipped and moved to the next PCB. 
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NG-ID Button

Highlight Current Block on PCB Map
Darken the map view except selected block when block is set to PCB.

Highlight blocks with color
Highlights current block with red when NG data is there, with green when no NGs.

Block color density
Choose density of block color from 0-9.

XML3

Output XML data.

Save XML3 file
Output XML file to designated folder.  Set "Shift", "System type", "Family", and "Resource".
It is used to XML output.

It is sent to a server
Output text string of XML to designated server.  Set "URL", "Station name", and 
"Communication port with AOI".

     

10 Key
Use Numeric Keypad Shortcuts
Possible to set the operation when you press numeric keypad.  Select the operation from 
pull down menu for numeric keypad from Tenkey 0 to Tenkey 9.
You can select the operation among following;
OK, NG, Rep, PCB OK, PCB NG, PCB Rep, PCB Scrap, Prev PCB, Next PCB, Prev NG,
Next NG, A, B, Reload
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Division judgement
Division judgement is performed
Displays only selected block number data.

Judged block number
Selects specified block number.

This CsRepair is the last block
Sets whether the selected block number is last. The setting is renewed if you tick it.

User
Register messages for current Ref.Des. or change column name of Ref.Des.
See  P.34 "Operator Area" for details.

CSV
Save CSV file
If it is active, CSV file is saved on the folder you choose.

Output
Set [File per PCB] to output information for each sub PCB.

PCB without barcodes are not output as files
When the option is ON, PCBs without barcodes are not output to file.

NG of Blockmark is judged as OK
For the PCBs that are judged as NG by the BlockMark stamp, they are treated as OK.
When the option is ON, the judgment is indicated as 'BM' when the file is output. When the 
option is OFF, it is judged as NG.

Output operator information
Outputs the registered login name using the inspection machine and CS-Repair.

Conveyor
Option for communication with dedicated systems. Please contact your distributor for 
details.



- 25 -

CS-Repair Operation manual

Window Color

Enable to customize screen display color.
As window color setting dialog is displayed, set the display color and click the set button. To 
change the display color, click the colored frame of the window first.
As the color dialog is displayed, select the color. To make a new color, make a color by clicking 
the color-making button and click the addition button.

Grid
Customize the color of the grid.

NG Mark
Customize the color of the NG marks displayed in the PCB map.

False NG mark
Customize the color of the false NG marks displayed in the PCB map.

Mouse selected mark
Customize the color of the mouse selected mark displayed in the PCB map.

Current mark
Customize the color of the NG marks of current Ref Des. displayed in the PCB map when 
'Display all marks on Ref Des anytime' is on in Action tab of General Settings.

OK mark
Customize the color of the false NG marks displayed in the PCB map when 'Display all 
marks on Ref Des anytime' is on in Action tab of General Settings.

Cross Line
Customize the color of the cross line mark displayed in the PCB map.

     

NG Classification ID

The NG ID window is displayed. It serves as a useful reference for input of NG ID from the 
keyboard when classifying NG in cause or phenomenon. The item can be edited by double-
clicking on white columns. To quit from editing, press Enter, or click other space. 

Export
Outputs the displayed NG-ID items to an arbitrary file.

Import
Reads NG-ID items from the file and displays them on the screen.
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Save
Saves displayed NG-ID items.

 

NG-ID Color

Changes the color of NG-ID button.

Applies to all NGIDs
Applies the currently displayed settings to all NG-ID buttons.

NGID Group Setting

This window allows you to specify the range of NG-ID buttons to be displayed and to set 
the shortcut key assignment. By setting multiple NG-ID buttons, you can switch the NG-ID 
buttons to be displayed for each inspection type. Click [Settings] - [NG classification ID] - [NG 
ID] - [NGID Group Setting] to display this window.

ID Range

Start
Specifies the starting number of the NGID to be displayed.

End
Specifies the end number of the NGID to be displayed.

NGID Key
Assigns the NG-ID within the display ID range to the 0-9 and A-Z keys. B, N, and R key 
cannot be set because they have already been used in another process.

Create a new file 
Creates a new NGID Group Setting file.

Update 
Updates and saves the currently selected NGID Group Setting file.

Delete 
Deletes the currently selected NGID Group Setting file.
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Operator ID

Repair operator ID can be set to identify the worker. ID can be set in numbers, and can be edit 
from 'Operator ID Edit' in Settings. Current Operator ID is displayed in top right corner of main 
screen.  If you want to check ID history, open the property.

    

Operator ID Edit

Enable to edit operator ID and operator name. Select an item to edit.
Add:  Add a new operator. A new dialogue pops up for inserting data. 
Edit:  Select one of the operator, triple click the field, then the field will be editable.
  After editing select this menu to update.  
Delete:  Select one of the operator and select this menu to delete.

* Edit menu can also be displayed by clicking on right button of mouse in the fields.
* You can also edit this menu by clicking each field, however in this method, you always have 

to update each change after editing.

Working Time

If operators are working according to schedule, you can set working hour. It helps to trace or 
analyze data in the future.

Barcode Search Filter

When multiple AOI is connected to CS-Center and same inspection program is inspected 
on more than one AOI, sometimes operator makes mistake of which AOI's data should be 
classified. By Filterng AOI in advance, only data of selected AOI will be shown.
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Language

Set the language.  Select language from Chinese, English, Japanese, or Korean.

Window

Display Toolbar1

Toolbar1 is displayed. Press this button when you close Toolbar1 and want to open again.

Display Toolbar2

Toolbar2 is displayed. Press this button when you close Toolbar2 and want to open again.

Display Toolbar3

Toolbar3 is displayed. Press this button when you close Toolbar3 and want to open again.

Initialize Toolbar

Make Toolbar display on default.

Float Toolbar1

Make Toolbar1 floating.

Float Toolbar2

Make Toolbar2 floating.

Float Toolbar3

Make Toolbar3 floating.

Initialize Window

Get Window size and position back to default

Help

Help

Display help menu.

About CsRepair

Display version and information of CS-Repair.
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10.  Buttons in Main Window

Open

 Select data from database. Same as 'Open' in File menu.

PCB inspected

 The number of total inspected PCB is displayed. By clicing Number input dialog pops up.
By inputting number, you can jump to the target PCB. This function is same as 'Number' in 'Jump 
by PCB' in View menu.

Reload 

 Refresh current data, if inspection continues, then additional inspection data is loaded. Same 
as 'Reload' in File menu.

Print 

 Print current PCB's inspection data, map view and Ref.Des.

Previous button (PCB_status)

Displays the previous PCB data.

Next button (PCB_status)

Displays the next PCB data.

Reload button (PCB_status)

This button has the same function as the Reload button  on the top of the screen.
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Previous PCB

 Move to previous PCB. Same as 'Previous' in 'Jump by PCB' in View menu.

Next PCB

Move to next PCB. Same as 'Next' in 'Jump by PCB' in View menu.

   

Previous Ref Des

Move to previous Reference Designator (inspection point). Same as 'Previous' in 'Jump by Ref 
Des' in View menu.

Next Ref Des

Move to next Reference Designator (inspection point). Same as 'Next' in 'Jump by Ref Des' in 
View menu.
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Zoom PCB map

 Zoom-in the PCB map. Clicking this button enlarge the PCB map by keeping height vs width 
ratio.   However, it cannot be enlarged over the maximum area of the screen. From pull-down next 
to glass icon, you can select zooming size. If you select Save As, you can save PCB map in BMP 
or JPG.

   

Grid

Display grid in PCB map. Click this button again, then grid will not be displayed.

NG 

 Display NG inspection points only in PCB map. 
Remarks: If only this button is pressed, PCB without NG will not be listed on PCB status window 
and False NG / OK inspection points will not be listed on Ref Des Status window.
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Good

 Display False NG inspection points only in PCB map.
Remarks: If only this button is pressed, PCB without False NG will not be listed on PCB status 
window and NG / OK inspection points will not be listed on Ref Des Status window.

OK

 Display OK inspection points only in PCB map.
Remarks: If only this button is pressed, PCB without OK inspection point will not be listed on PCB 
status window and NG / False NG inspection points will not be listed on Ref Des Status window..

Zoom point picture

 Zoom-in the Reference Designator (inspection point) picture. Clicking this button enlarge the 
picture by keeping height vs width ratio.   However, it cannot be enlarged over the maximum area 
of the screen. From pull-down next to glass icon, you can select zooming size. If you select Save 
As, you can save PCB map in BMP or JPG.
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Capture

 Display images taken by Capture Stamp in inspection program. Image taken by Capture Stamp 
is stored also in database. Images are listed on left bottom. Select image to display.
You can close this window by one click. You can enlarge the picture by dragging window, and by 
clicking right mouse you can display the image in original size.

Rotate PCB

 Rotate PCB -90 degrees by one click.

Show Angular Camera images

 opens new window to display images taken by angular cameras.

Mirror

 Display Map view with right and left inverted.

Barcode

 Change the Block barcode of selected point.

X02W 3D View

 Displays the confirmation screen for 3D data acquired by X02W.

List

 Displays detailed data for X02W inspection results.

A face

 Select A (surface) face

B face

 Select B (back) face.
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11.  Window Operation

You can change the window size by dragging the splitter of the window.

1. PCB Map

2.Inspection
   point picture

3.Operation
   Area

4.PCB status
   window

5.RefDes 
status window

PCB map

The window where picture of PCB is displayed.

Zoom-in

Zoom-in PCB map by selecting percentabe or input zooming %, or make PCB map size to fit 
the PCB map window area by selecting Adjust size.
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Select by mouse

Bringing the mouse close to the mark displayed on the screen changes the shape of the 
mouse to a hand. Clicking the mouse when it is in the shape of a hand makes the mark into the 
status of being selected and the color changes. The selected location's picture is displayed in 
inspection point picture window.

Save As

Sub-menu pops up when you click right mouse button on PCB map.  You can save the 
displayed PCB map image by clicking Save As.  Designate the folder and name, and click 
Save button.

Inspection point picture

The window where picture of inspection point (Reference Designator) is displayed.
Pop-up menu is displayed with right click.  You can zoom-in the picture by selecting zooming % 
(100% to 300%).  You can also make the picture size to fit the inspection point window area by 
selecting Adjust size.  With zoomed-in status, you can move the displayed image by left clicking 
the mouse and dragging.  Also you can move the displayed image by moving scroll bar at the right 
and at the bottom.

  

Save As

Sub-menu pops up when you click right mouse button on inspection point picture.
You can save the displayed inspection point picture (Reference Designator) by clicking Save 
As.  Designate the folder and name, and click Save button.

Operator area

The 1/3 of right side of Main Window is the area used by operator.



CS-Repair Operation manual

- 36 -

Operator ID

Operator ID and name is displayed if you input operator ID from 'Operator ID' in Settings 
Menu.  By pressing ID or name button, you can set/change/edit operator.

PCB Selection

Buttons to move to previous or next PCB. Equal to PageUp and PageDown keys on keyboard.

Bar Code

Barcode number of the PCB is displayed.  By pressing button, you can search PCB by 
inputting barcode.

Lot

Lot number is displayed.

Inspected

Date and hour of inspection.

Order

PCB number out of total in current data.

AOI-ID & Name

Name of AOI (Mac) and name of inspection program.  By pressing button, you can call 'Select 
Data' window. 

Total Checked

Number of inspection points (Reference Designators) on the PCB is displayed

Total NG

Number of NG inspection points (Reference Designators) on the PCB is displayed.

OK

*Not shown in V1.4.0.0 or later.
Classify current PCB OK. 
After pressing this button, OK will be fed back on Check column in PCB status window.

NG

*Not shown in V1.4.0.0 or later.
Classify current PCB NG. 
After pressing this button, NG will be fed back on Check column in PCB status window.

Rep

Classify current PCB Repaired.
After pressing this button, Rep will be fed back on Check column in PCB status window.
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Scrap

Classifies the inspection decision as Scrap.
When a block is set, Scrap is set only for the block in which the currently selected Ref.des. 
is placed. When Ref.des. that has been set to [Scrap] is selected, [Scrap] is displayed at the 
bottom of the barcode field. To set the inspection result to [Scrap] for data with blocks, use the 
right-click menu on the PCB selection screen. 
Individual judgment cannot be set for the area (whole or block) that has been set to Scrap. If 
you want to change each result, set the judgment to unconfirmed.

NGID Group

NG-ID Group Setting list is displayed. The number of NGIDs will vary depending on the NGID 
group you select. 

Classinformation buttons

You can classify each inspection point (Reference Designator) by ten keys and arrow keys. 
Some keys are also used to move next/previous inspection point or PCB.

PCB Status window

This is the window to display PCB in list. By clicking a PCB, the PCB is selected and displayed. By 
clicking right mouse button, the sub-menu pops up.
OK Classifies the PCB as OK.
NG Classifies the PCB as NG.
Scrap Classifies the PCB as scrap.
Warning Classifies the PCB as warning.
Repair Classifies the PCB as repaired.
Undo Sets the inspection result as not confirmed status.
Property Displays the PCB classification details.

Rack

Rack column represents: Rack number - shelf position / total shelves number in a rack
You can set the rack status from pop-up menu by right clicking rack column.

Number of shelf in a rack

Set the number of shelf (how many PCB to contain).

Starting rack number

Set the starting number of racks. On default, the number is 1, but if you want to repair/classify 
from another number, specify the number here.

Starting shelf number

Set the starting number of shelves in the rack. If you set the number then the PCB with earlier 
numbers are not displayed on the PCB list.
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Ref Des Status window

This is the window to display inspection points (Reference Designators or Ref Des) in list. By click-
ing one, the inspection point is selected and displayed. By clicking right mouse button, the sub-
menu pops up.  
OK Classifies the inspection point (Ref Des) as OK.
NG Classifies the inspection point (Ref Des) as NG.
Warning Classifies the inspection point (Ref Des) as warning.
Repair Classifies the inspection point (Ref Des) as repaired.

Undo Sets the confirmation result of Reference Designators as not 
confirmed status.

Property Displays the classification details of confirmation result of 
Ref Des.

Select columns

Set the items to be displayed on the window. Cannot be used when [Activate A/B Tree View] is 
ON and [Display grid] is OFF in the [A/B Tree View] settings.
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Keyboard functions

Shortcut

Open database   Ctrl + O
Reload    Ctrl + N
Search by barcode     B 

Arrow keys

Up            Classify current inspection point (Ref Des) OK and move to the next point.
Down           Classify current inspection point (Ref Des) NG and move to the next point.
Right            Move to the next point.
Left            Move to the previous point.

Function keys

F1    Classify current PCB OK
F2    Classify current PCB NG
F3    Classify current PCB Repaired
F4    Undo PCB classification
F5    Classify current inspection point (Ref Des) OK
F6    Classify current inspection point (Ref Des) NG
F7    Classify current inspection point (Ref Des) Repaired
F8    Undo inspection point (Ref Des) classification
F9    Zoom-in inspection point (Ref Des) picture　

Other keys

Tab    Move to the next tab page of NG-ID button
Shift + Tab    Move to the previous tab page of NG-ID button
PageUp  Display the previous PCB
PageDown  Display the next PCB

12. Using external Barcode Reader

You can use USB interface or keyboard interface barcode reader. 

Barcode reader settings

Please set barcode reader as followings:
 Header:   Null
 Terminator:  CR
 Data format: Data + Terminator

Barcode input

Barcode can be input by one of the following methods when the CS-Repair is running and other 
dialogs are not displayed.
1. To activate the barcode reader
2. To enter in the barcode input dialog displayed from [File] - [Barcode input]
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13. Basic Operation

Select data

Select data from 'Open' in File menu or open icon in tool bar. Select target data by sorting from 
PC Name, PCB, Lot number, production period (From To) and SIDE.
You can also select data by pressing Bar Code, AOI-ID or Name buttons in Operation area. 
Preview of PCB map is displayed on right bottom by selecting data from list, this can be a good 
reference to select data. And if you press Preview button, the larger size PCB map is displayed in 
new window.

Identify operator and customize screen

Identify operator

Set your (operator's) ID in Operation area.

Set PCB map what to display

Select buttons NG / Good / OK from toolbar in order to display the marks on PCB map 
according to your purpose. For example,
- If you just want to check defective points, activate NG only.
- If you are supervisor and want to check the judgement skill of AOI operator, activate all three  
  buttons. Then you can check if AOI operator's skill is good enough or not.

  Remarks: If you do not check on 'Result includes OK data (dx, dy)' in Lan tab of Setting for 
supervisor on 22xx software, OK data is not collected, and will not be displayed on CS-
Repair. 

Set NG-ID (classify NG in error type)

If you want to classify defects by phenomenon, you can set 256 of NG classification ID in 
Settings menu. If you set NG-ID and classify NG inspection points, the classification data 
will help you to analyze PCB production status. For setting details, please refer to P.24 NG 
classification ID. 

NG reference designator and NG PCBs

Take actual PCB in your hand, and check the defective points by referring CS-Repair data.

Check inspection point (Reference Designator)

To select inspection point, press the Ref Des previous and next buttons or the left and right 
arrow keys on the keyboard displays the next or previous inspection point (Ref Des). Or select 
point (Ref Des) from Ref Des Status window. Or click the mark on PCB map.
Classify the inspection point “OK”, “NG (NG-ID)” or “Repair” by up and down arrow keys, or 
ten keys. Sometimes during work, you maybe in need of checking the defective point very 
carefully. To zoom-in point picture in new window, press F9. To zoom-out, press F9 again. 
You can keep working with the new window for zoom-in picture open, such as move to next 
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inspection point or next PCB.

Check PCB

After checking all inspection points, classify PCB “OK” “NG” or “Repair” depending on the 
results. PCB classification is automatically done after you classify all inspection points. If you 
skip classifying each inspection point, still you can classify PCB by pressing OK, NG or Rep 
buttons in operation area. To move between PCB, click on the previous PCB and next PCB 
buttons or / and * keys on the ten key to display the next or previous PCB. Or select PCB 
from PCB Status window.  If you operate by keyboard, F1="OK", F2="NG", F3="Repair", and 
F4="Undo".

Load new data

If inspection is continuing, press Reload button on tool bar or 'Reload' from File menu to load 
the latest data.

14. View images from Angular Cameras

If your AOI has angular cameras, you can send images to CS-Center, and confirm on CS-Repair.
* If you always classify/verify with Angular Camera images, we recommend to use wide 

monitor or dual monitors for easy to see screen.

Select a reference designator. Click angular camera icon on menu bar, new window to show the 
angular camera image opens.

* If the icon is greyed out, it means that angular camera image is not taken.
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- Angular Camera view window is resizable.
- By clicking any of 9 view, you can enlarge the view.
- Save image by clicking with right mouse button.

               

15. About Tree View

If PCB has data of both A face and B face, both data can be invoked by selecting either data.  
When you load the data, PCB list is displayed at the left side in the screen.  From this list, you can 
check the result of each symbol.

Tree will unfold by clicking left end.  Content of the tree is as follows
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PCB map of A face and B face is displayed in top center.  The background of selected face is 
colored in yellow.
If B face is displayed, the list in the left side is for the current displayed PCB.
 
NG picture of selected symbol in selected face is displayed in lower center left.
Image from side camera of selected symbol is displayed in lower center right.

16. How to Check Data for Dual Inspection Machine

Tick Activate A/B Tree View and Display grid on A/B Tree View tab on General Settings.to 
check inspection data for dual inspection machene. By this setting, you can check results of both 
Side-A and B.

Select data after ticking as above. Map Views of both sides are displayed on the center. Also, PCB 
status of both side is displayed on PCB list.
Click A/B button on toolbar or operator area to switch Ref.Des. of each side.

PCB Status

A side Map B side Map

A/B button

A/B button

Ref. Des.
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17. How to operate 3D inspection machine data

Result data from 3D inspection machine has additional functions such as displaying 3D images 
and setting multiple inspection items in a single inspection frame. This section introduces the 
functions and operation methods for 3D inspection systems.

X02W 3D View

 Displays the confirmation screen for 3D data acquired by X02W.

List

 Displays detailed data for X02W inspection results.

2D Images

For 3D inspection machine, there are two types of inspection images: 2D and 3D. 2D images 
are displayed in the same position as the normal individual pictures.
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Display Information in Image

For 3D inspection machine, the display/non-display of NG content in the image can be 
switched using the right-click menu [Display NG Content] on the image.

Result List

The 3D inspection machine allows multiple inspection items to in a single inspection frame, and 
thus provides a function to check the results of each inspection item. The results are displayed 
in red if the inspection decision is NG, and in blue if the decision is OK.

The informations are as follows. 
Symbol Ref.des. information.
Type The type of inspection frame selected.
Judge The inspection result.
PinLength Pin length (mm) measured at the time of inspection.
Volume_1 Solder volume (mm3) measured at the inspection.
RedEye Length of no solder area (mm) measured at the time of inspection.
Existence (Height) Height (mm) within the inspection frame.
Existence (Volume) Area value (mm2) within the inspection frame.
X The coordinates X of the inspection point.
Y The coordinates Y of the inspection point.
board ID PCB ID set on the inspection machine.
Arrangement ID Inspection frame ID set on the inspection machine.
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X02W 3D Window

A window to confirm the 3D image taken with a 3D AOI X02W series. Click  button to open it.

Items on the screen are as below.
No. Name Function

1 Color range
The color distribution range according to the height difference on 
the PCB. Slide the upper and lower bars to adjust the height range.

2 Blend bar
Slide the bar to blend the color range. The upper limit displays only 
the color range, and the lower limit displays only the PCB color.

3 Range fit Match the color distribution to the height difference of the target.
4 Range reset Resets the color distribution to its initial value.
5 Camera buttons Adjust the viewpoint. See next page for details.

Range fit Range reset

1

2

3
4

5
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Camera buttons

You can see the object from different angles.

The function of camera buttons are as below.
Icons Name Function

 X axis Rotates the camera around the X axis in the direction of the arrow.

 Y axis Rotates the camera around the Y axis in the direction of the arrow.

 Z axis Rotates the camera around the Z axis in the direction of the arrow.

Z axis continuous Automatically rotates the camera continuously around the Z axis.

 View 1/View 2 Switches to the 3D perspective view from the selected angle.

Camera View Switches to the display of the camera's field of view.

Map View Switches to Map View display.

Camera Reset Resets the viewpoint.

2D button
Switches between 3D mode and 2D mode. If zooming or camera 
movement was performed from a 3D, the perspective is reset.

2D button active The buttons change color when 2D mode is being executed.

Dragging the screen while holding down a specific key will move the viewpoint freely.
Key Name Function
Ctrl Rotate Rotate the 3D image in the XYZ direction.
Shift Vertical move Moves the 2D image in the XY direction.

The 3D image display tool for X02W can be used under the following conditions.

・DirectX 11 compatible graphics card

・64bit operating system
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18. Errors

Message Explanation Measurement
Incorrect key number The key number you input is incor-

rect
Please input correct key number.

Invalid key number entry.
Installation failed Failed to install CS-Repair Please re-try installation.
Please re-install
No printer installed Tried to print but printer not found Please confirm the printer settings.
File incorrect Setting file imported is incorrect Please select correct setting file.
No corresponding data found Data for the barcode num. not found. Please confirm the barcode num. or 

check the barcode search setting.
No valid data found The targe PCB was not found Activate light-blue circle (show OK 

PCB)
HASP key not found HASP key not working correctly, or 

driver error.
Confirm the connection of the key, 
confirm if correct driver is installed.

If error is not improved, contact to 
your local reseller.

HASP key version invalid
HASP key not found or key ID incor-
rect Error
Hasp.dll loading error
Hasp key routine not found
Data is occupied by another user, 
could not update

Another operator is working on the 
same PCB, or there is communica-
tion problem between database. 

Work on the another PCB or confirm 
the connection with database.

Data is not read. Error shown when executing filtering 
before loading data

Execute filtering after loading data

Error occurred by the CsWatch 
transmission.

Failed to send the result to CS-
Watch.

Confirm the port/IP setting in Watch 
tab in general settings. Confirm also 
the settings on CS-Watch.

"N" key is disabled, if you like to use, 
please activate in General settings

Pressing N key does not work as 
classifying Reference Designator as 
NG.

Activate "Use A-Z keys for classifica-
tion".

"R" key is disabled, if you like to use, 
please activate in General settings

Pressing R key does not work as 
classifying Reference Designator as 
Repair.

Activate "Use A-Z keys for classifica-
tion".

Save error XML file was not saved in the desti-
nation.

Confirm the existance of folder (des-
tination) and database connection

When a hierarchical display is ef-
fective, it cannot validate [Load side 
B too by searching side A block 
barcode].

Some functions can't be active when 
tree view is active.

Confirm the settings necessary for 
tree view.

It repeals [Load side B too by 
searching side A block barcode].
When a Tree view display is enabled, 
it cannot use [Load both side A and 
B automatically].
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Message Explanation Measurement
Another operator is accessing this 
data, could not update data.

Communication problem with data-
base.

Confirm the setting with database.

Renewal right couldnot be acquired. 
It canot be renewed.
The error occurred by the DB data 
acquisition.
The error occurred by PC name 
acquisition.
The error occurred by PCB acquisi-
tion.
The error occurred by PART acquisi-
tion.
The error occurred by the date ac-
quisition.
The error occurred by the image 
acquisition.
The error occurred by positional 
acquisition.

Communication problem with data-
base.

Confirm the setting with database.

The error occurred by the repair 
results acquisition.
The error occurred by REP acquisi-
tion.
The error occurred by the bar code 
acquisition.
The error occurred by writing PART. Problem happens while exporting 

data
Confirm the setting of export

The error occurred by writing REP. Problem happens while deleting data 
(e.g. date setting)

Confirm the setting of deletion
The error occurred by the data dele-
tion.
The error occurred by the fraction 
defective acquisition.

SPI data was not found in the folder Confirm the connection to SPI ma-
chine and settings.

The error occurred by the device 
total acquisition.

SPI data was not deleted after im-
porting to CS-Center

The error occurred by the mark ac-
quisition.

SPI data is not saved by CS-Center

The error occurred by the mark 
change.

Can't find the folder where SPI data 
is saved.

The error occurred by the result 
change.

There are same folders to save SPI 
data

Change the folder setting to correct 
SPI folder.

The error occurred by the lock re-
lease.

Input other than numbers to port Input correct port number

The error occurred by the NG-ID 
change.

Port number out of range Input port number within range.

The error occurred by the judgment 
acquisition.

Port number for SPI machine is over-
wrapping

Input non overwrap numbers.
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Message Explanation Measurement
The error occurred by the result 
acquisition.

Communication problem with data-
base.

Confirm the setting with database.

The error occurred by writing result.
The error occurred by the person ac-
quisition. PostgreSQL may suspend 
it.
The error occurred by writing person.
The error occurred by the person 
deletion.
Error occurred by warmup. Post-
greSQL may suspend it.
PCB map file is not found.
An individual picture file is not found.
The error occurred by the ID acquisi-
tion of the cell.
The error occurred by the unjudg-
ment number acquisition.
It was not possible to connect it with 
DB. Please review the setting of DB.
Error occurred by the rep table mak-
ing.
Since there is no data of A side, it 
cannot display.
Invalid value Incorrect setting to delete data. Confirm the setting for deletion.
There is no data to delete for the 
month
Could not delete data
Error during deleting Jpeg file
Time order is reversed between From 
and To, are you sure to continue?

Date for From and To is set opposite. Please apply the correct date.

Can not connect to Barcode Reader.
COM port may be occupied by other 
device.

There is communication or setting 
problem for RS-232C barcode scan-
ner.

Please confirm the settings.

Can not get information from Bar-
code Reader. 1: GetCommState
Can not set Barcode Reader. 2: Set-
CommState
Could not receive the data. s1
Could not read the data. s4
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